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USER GUIDE 
 

Introduction 
This User Guide is designed to serve as a brief overview to help you get started. There is also information available under the Help 
option in the various Contributor interface toolbar. If necessary you can access the Help by launching the Contributor interface from 
the System Tray and selecting Help->Help and Support. 
 
If you would like further instructions, please consult the Features list at http://support.colligo.com/Lists/Features/AllItems.aspx - 
where you will find a complete list of features by product along with instructions for use. You will also find a number of screencasts 
on the support site that walk you through the main product features. The SharePoint support site can be synchronized with Colligo 
Contributor for anytime access, online or offline. Please follow the instructions on the home page at http://support.colligo.com/.  
 
We hope you enjoy using the product, and please don’t hesitate to send us questions or provide feedback at support@colligo.com. 
Thank You. 
 
 

  

http://support.colligo.com/Lists/Features/AllItems.aspx
http://support.colligo.com/Lists/Screencast/screencasts.aspx
http://vs-sharepoint/default.aspx
mailto:support@colligo.com
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Installing Colligo Contributor 
 

Systems Supported 
 Microsoft® Windows® 7 Home Premium; Professional or Ultimate. 

 Microsoft® Windows® Vista Business; Enterprise or Ultimate. 

 Microsoft® Windows® XP Home or Professional 

 Microsoft® Windows® 2000 Service Pack 2 or greater 

 Microsoft Office 2000 – 2010(Office 2003 SP2 or later for InfoPath forms) 

 Internet Explorer 6.0 or later 

 SharePoint Server 2010, MOSS 2007 and SPS 2003; SharePoint Foundation and WSS (2.0 or 3.0) 

 Consumes  roughly 20MB of disk space, not including content 

 If you have a previous version installed, the new version can be installed “over top” of the old version without needing to 
uninstall. This will also preserve all of the cached content.  

 

Application Prerequisites 
 .NET Framework 2.0 - For XP or 2000, please ensure the .NET Framework 2.0 is installed first (included with Vista). You can 

check in the Control Panel > Add/Remove Program. 

 .NET Framework 3.0 - Required to support embedding and extraction of metadata from Office 2007 documents. 

 
Outlook Add-in Prerequisites 

 Compatible version of Outlook (Outlook 2010, 2007 or 2003) 

 Office 2003 or Office 2007 Primary Interop Assemblies (depending on which version of Office is installed) 

 Microsoft Visual Studio 2005 Tools for Office Second Edition (VSTO 2005 SE) Runtime 

 Microsoft Visual C++ 2008 SP1 Redistributable Package 
 

Interactive EXE Install 
1. Download the Colligo Contributor EXE installation file to your local computer.  
2. Double-click on the installation file to install Colligo Contributor.  
3. Prerequisites are downloaded and installed. 
4. Enter your license key.   
5. Colligo Contributor can be set to launch at Windows Start Up. This will enable the background synchronization to start 

automatically.  
 

Interactive MSI Install 
1. Check and ensure the prerequisites are installed. 
2. Download the Colligo Contributor MSI installation file to your local computer.  
3. Double-click on the installation file to install Colligo Contributor.  
4. Enter your license key. 

 

Terminal Server Install 
For information on installing in a Terminal Server environment see the Colligo Contributor Terminal Server User Guide 
 

Other Installation Options 
More details on installation are available on the support site:  
http://support.colligo.com/Lists/Knowledge%20Base/DispForm.aspx?ID=16 

 

Notes 
 Concurrent version installations 

Colligo does *not* support side-by-side installations, running multiple versions or different versions of Contributor. 
Version reversion/downgrading 
It is *not* possible to revert to an earlier version of Contributor after upgrading as the database is often updated.  

 Microsoft® Windows® 2000 
Microsoft® Office® 2007 is *not* supported on Microsoft® Windows® 2000. Contributor does *not* support metadata 
embedding and extraction from Office® 2007 documents on Windows® 2000 systems. 

http://www.colligo.com/_documents/Colligo_Contributor_Terminal_Server_User_Guide.pdf
http://support.colligo.com/Lists/Knowledge%20Base/DispForm.aspx?ID=16
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The Outlook Add-In 

Adding a Site to Outlook 
 
It is possible to add a site to Contributor in a number of other ways, including: 

 Use the “Connect to Outlook” option in Internet Explorer 

 Site -> Download Site menu option 

 Click the site selector drop-down and select “Download Site…” 

 Drag and Drop a URL from IE Into Contributor 
 
The simplest approach is using the “Connect to Outlook” option. This process is described below. 
 

Step 1: IE Toolbar button “Connect to Outlook” 

 
Navigate to a SharePoint List or Library in Internet Explorer Click the yellow “Connect to Outlook” icon on the toolbar 
 

 
 

 

Step 2: Confirm the connection in Outlook 

Contributor will start Outlook if it is not already running and confirm that you wish to connect the library to Outlook. 
You may choose to connect the List ‘Online’ or ‘Cached’. 

 

 
 

For an introduction to the difference between “Online” and “Cached” read the Contributor Add-In Cached vs Online section of this 
document. 
 
You may be prompted for credentials to connect to the SharePoint site.  You may use your default Windows credentials, or supply 
other specific credentials. 
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If the “Connect to Outlook” process is started on a page that does not relate to a SharePoint List you will receive a message box as 
shown below. Simply click OK, navigate to a List in IE and click “Connect to Outlook again. 
 

 

 
Step 3: Use the Contributor Add-In 

Once Contributor has finished downloading the List definitions the folders are made available in Outlook. 
Contributor will build out a tree for the subfolders of the selected document library. 
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Contributor Add-In Cached –vs- Online 
Contributor Add-In functions in two ‘Modes’, Online and Cached.  
If you attempt connect a list to Outlook that has already been synchronized in Cached Mode Outlook will present the SharePoint 
View of the list, however the list will remain synchronized in Cached Mode. 
 
The Online and Cached views are presented below: 
 

Cached View 

 

Online View 

 
 
 
 

Online Mode 

Key functionality of Contributor Add-In operating in Online Mode is: 

 Does not maintain a cache of data  

 Upload content to SharePoint with metadata Prompt 

 View the SharePoint site in Outlook 

 Navigate through SharePoint site using Outlook folder tree 

 Automatically extract Email metadata (To, From, Sent, Subject, etc) 
 

Cached Mode 

Key functionality of Contributor Add-In operating in Cached Mode is: 

 Content is cached providing offline access 

 Upload content to SharePoint with metadata Prompt 

 Access and Edit existing SharePoint content including accessing metadata. 

 Automatically extract Email metadata (To, From, Sent, Subject, etc) 
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Editing content in Cached Mode 
 
Select the folder in Outlook to access the Contributor Add-In Cached-View of the List. 

 The Cached view provides access to the content. Here you can work with your content and perform the actions below: 

 Open a document by double-clicking on the item 

 Right-click on an item to: 
o Edit the properties (metadata) of the item. 
o Open/Edit a document 
o Check Out; Check In; or  Discard Check Out 
o Rename content 
o Delete content 

 

 
 

 
Creating new content in Cached Mode 
 
New content can be created by selecting the “New” option. 
On SharePoint 2007and 2010 sites content can be created based on content-type templates 
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Uploading existing content 
Using “Upload Documents” menu 

Existing content can be added to Contributor by selecting the “Upload” option 
Contributor will prompt for metadata when the document is uploaded. 
 

 
 

Using Drag-and-Drop 

Drag from your Inbox into the Outlook tree 
 Emails can be uploaded to SharePoint simply by drag-and-drop direct from your Inbox into a folder Connected to Outlook. 

 Contributor automatically extracts email metadata (To, From, Sent, Subject, etc) to similarly named SharePoint columns (if they 
are defined). 

 .msg format maintains fidelity of the message, including attachments 

 Unique SharePoint filename generated based on Sender, Sent, and, Subject 
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Drag from your Desktop into the Contributor Cached View 
 Files or Folder structures can be uploaded to SharePoint simply by drag-and-drop direct from your Desktop (or My Computer) 

into the Contributor Cached View in Outlook 

 Contributor will prompt for metadata 

 Contributor uploads the files and folders  to the selected library 

 
 

 
Drag from your Desktop into the Outlook tree 
 Files can be uploaded to SharePoint simply by drag-and-drop direct from your Desktop (or My Computer) into the Outlook 

folder tree 

 Contributor will prompt for metadata 

 Contributor uploads the file to the selected library 
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Drag attachment from an email into the Outlook tree 
 Attachments can be uploaded to SharePoint simply by drag-and-drop direct from an email into the Outlook folder tree (or 

Contributor Cached View). 

 Contributor will prompt for metadata 

 Contributor uploads the file to the selected library 
 

 
 

Using Send and File 

 Automatically store a copy of a sent email using the Send & File command in the Colligo Send & File toolbar 

 Select the destination SharePoint location using the Colligo for SharePoint folders in the Outlook folder tree 

 Filing Advisor suggestions locations based or recently used folders or email conversation. 

 Contributor automatically extracts email metadata (To, From, Sent, Subject, etc) to similarly named SharePoint columns. 

 .msg format maintains fidelity of the message, including attachments 

 Unique SharePoint filename generated based on Sender, Sent, and, Subject 
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Using Copy Folder 

 Folders and their contents (including sub-folders) from your Mailbox can be uploaded to SharePoint using the Copy folder 
command in the Colligo toolbar 

 A corresponding folder tree is created in SharePoint and the individual emails are uploaded. 

 Contributor automatically extracts email metadata (To, From, Sent, Subject, etc) to similarly named SharePoint columns. 

 .msg format maintains fidelity of the message, including attachments 

 Unique SharePoint filename generated based on Sender, Sent, and, Subject 
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Copying existing content in Cached View 
Drag-and-drop 

Existing content, files or folder structures, can be copied between SharePoint document libraries or folders by a drag and drop 
operation. A new copy of the files or folders is created in the destination location and Contributor will prompt for metadata. In cases 
where the metadata structure in the destination library is different from the source library Contributor will make a best effort to 
match and retain existing metadata values. 

 
Emailing content as an Attachment 
Upload Attachment 

You can share content with other users by sending them a link (SharePoint URL) to the content rather than an attached file. When 
creating an email there is a Contributor toolbar to upload an item and replace it with a link. 
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Insert SharePoint URL 

You can share content from the cache with other users by using the Insert command.  Insert Attachment formats the URL and inserts 
it at the top of the body of the email as if it had just been uploaded. Insert Text link inserts the URL at the current cursor location for 
inline URLs. 

 

 
 

Attachment Rules 

Contributor will warn or prevent emails from being sent if the total size of attachments exceeds a defined limit. If this limit is 
exceeded then some attachments may be removed or uploaded to SharePoint and replaced with their URLs. The current limits can 
be seen with the Rules command. 
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Share Content with other users 
 

Copy SharePoint URL 

You can share content with other users by right-clicking on an item and selecting “Copy SharePoint URL”, URLs for the selected 
item(s) are copied to your clipboard and can be pasted into many applications, files, or emails. 

 

Drag-and-Drop 

Alternatively, for users that do not have access to the SharePoint site it is possible to drag and drop files or folder structures from 
the Contributor Cached View into an email, Windows folder, or other suitable application. 
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Default Metadata and Prompting Behavior 
Contributor allows you to specify default values for metadata. Default values can be set at a document library, or sub-folder level. 
The default values support both inheritance and propagation.  
 

Introducing the Metadata Dialog 
A sample of the Default Metadata dialog is displayed below. The following table explains the function of the dialog. 
 

 

List  Selector Panel 
 

The List Selector allows you to change the List or Subfolder you wish to work with. 
NOTE: The List selector is only visible if the dialog is access through the File menu. 

Default Value Settings 
 

Name The Display Name of the SharePoint column 

Value The default value to be applied. 

Inherited From Indicates where Contributor receives this value from. The ‘Inherit From’ column 
may take the following values: 

 SharePoint Column definition 

 <not inherited> 
Parent Object Name. This may be the name of a document library of parent 
folder. 

Apply To Indicates whether the default value may be inherited by a subfolder. The ‘Apply 
To’ folder may take the following values: 

 This Folder and subfolders 

 This Folder only 

Add, Edit and Remove 
 

This buttons allow you to work with the locally-defined default values.  
Multiple items can be selected for removal using the Windows standard Ctrl and Shift selection 
modifiers. 

Inherit propagating 
values from parent 
items 

This folder will inherit propagating values from the parent item. Values specified with ‘This Folder 
and subfolders’ are propagating values and may be inherited. 
When un-checking the option Contributor provides the option to copy inherited values locally. 

Clear locally-defined 
values on all child items 

 
When settings are applied with this values checked, child-items are reset to inherit values; any user-
specified default values on child-items are cleared. 

Prompting Behavior 
 

Modify the prompting behavior. The options are: 

 Always: The metadata prompt will be displayed when an item is added 

 Never: The metadata prompt will *not* be displayed when an item is added 

 According to application global settings: Prompting behavior is as defined in the View-> 
Options dialog 

Child-items that are configured for inheritance will inherit this setting. 

 

 

 
1. List  Selector Panel 

 
2. Default Value Settings 

 
3. Add, Edit and Remove 

 
4. Inherit propagating values from parent 

items 
 

5. Clear locally-defined values on all child 
items 
 

6. Prompting Behavior 
 

1 2 

3 

5 

6 
4 
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Accessing the Dialog 
File Menu 

The file menu may offer different options according to the flavor of Contributor deployed. The Contributor Control Panel interface 
may be accessed by double-clicking the Contributor icon in the system tray.  
 

   
                              Control Panel  

 
* When accessed through the File menu, the Default Metadata dialog includes the List Selector Panel. 

 
 

Synchronizing Content 
Contributor offers different user-configurable synchronization processes to ensure data is kept synchronized with SharePoint. 
Synchronization runs silently in the background allowing you to continue working with your documents. 
 

Automatic Synchronization processes 

 

 

Synchronize on startup 
Contributor synchronizes cached content when it starts 
 

Synchronize when list is viewed 
When you navigate to a list the content is synchronized 
 

Synchronized when list is modified 
Modifications include changes to the document or metadata 
 

Enable background synchronization 
Contributor synchronizes content periodically. The default sync-
interval is 30 minutes. 
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Manual Synchronization processes 
A synchronization cycle can be manually started using the Synchronize command in main toolbar or ribbon. 
 

 
 
 

Full Synchronization 

Several of the synchronization processes allow you to specify ‘Full Synchronization”. When Contributor performs a full 
synchronization additional information is downloaded, this includes definitions for Sites, Lists, Views and Content-Types, etc, plus 
other site-content that may not be retrieved during other standard sync processes. 

 


